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• Getting additional help for Territory
Design for ArcGIS

Welcome to ESRI® Territory Design for ArcGIS®. By using your own
custom boundaries or utilizing the geography layers within ArcGIS Business
Analyst you can create, edit, and balance your sales regions, services areas,
or franchise networks to benefit your business. Territory Design works with
ArcGIS Desktop to create powerful yet easy-to-use software.

Territory Design represents the latest major product enhancement from
earlier versions of ArcGIS Business Analyst. In addition to the familiar
wizards for analyzing data for stores, customers, and trade areas in
Business Analyst, Territory Design is also wizard driven, providing an easy-
to-use suite of tools to create and manage your territories.
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2 USING TERRITORY DESIGN FOR ARCGIS

Territory Design for ArcGIS offers an easy way to increase sales
force productivity by designing, analyzing and managing
geographic territories such as sales territories, franchise
territories, distribution networks or services areas. Since
territories are naturally geographic by design, utilizing this tool
allows you to look at how your current territories are distributed.
This capability is vital for revealing existing physical gaps in your
distribution network, areas where your sales are saturating a
market, and areas where your sales and customers are deficient.
Once a sales manager identifies these areas, the next logical step
is to fix the problem to increase sales and customer distribution.
Territory Design offers several tools to import, create, manage,
and balance territories:

Creating New Territories

• Based on a set of points to seed the territory creation

• Based on an existing database of territory assignments

• Can be performed manually

Balancing Territories

• Based on customer data

• Based on existing geographic/territory data, as well as any
data included with the Business Analyst extension

• Based on distance

Managing Territories

• Importing and viewing existing territories

• Adding/removing territories or any associated attributes

• Organizing and creating hierarchies for territories

• Benchmarking sales territories against demographics

Introduction to Territory Design for ArcGIS

Territory Design toolbar
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ABOUT TERRITORY DESIGN FOR ARCGIS 3

Territories are collections of geographic elements that are
aggregated to create a larger unit. For example, a set of ZIP Codes
around a service center can make up a territory for that service
center. Collections of these territories can then further be
summarized to create regions, districts, and the like. Territory
Design lets you import, create, and define as many levels of
territory hierarchy as you want.

Territory Design includes a suite of tools to create and optimize
territories. You can import an existing territory assignment
database and manually work with the Territory Design tools to
adjust and balance the territory assignments. Territory Design
includes a number of visualization windows (charts, data, and
statistics) where you can view the impact of reassigning an
element from one territory to another.

Territory Design includes a set of tools for automatically
balancing your territories. You can also create a set of territories
from scratch and optimize the territory distribution based on your
own sales data or any attributes that are provided with the
Business Analyst extension.

During the process of creating new territories you have several
options to view your sales territories. Say, for example, that you
have been tasked with streamlining the budget resources of your
division and the first step is to increase your margins and
customer base. The first part of this task is understanding where
your sales and customers are coming from and making sure your
sales force is appropriately distributed across your service area.
Many sales managers have only seen their sales numbers
associated with regions in spreadsheets and have never actually
visualized them. When creating new territories, you can import in
databases of sales and visualize your market. In the example on
this page, you can see a breakdown of sales territories by ZIP
Code with seed points that represent sales representatives. This
map illustrates how the existing sales territories have large gaps

between sales staff. In a market where your objective is to have
complete coverage and no cannibalization, it is imperative to
understand where your strengths and weaknesses are by
visualizing your database of sales territories.

Creating New Territories

A map showing sales territories with large gaps between territories
assinged to each office.
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4 USING TERRITORY DESIGN FOR ARCGIS

Territory Design can be used to properly redistribute your sales
territories and increase your customer base. For example, you can
use a set of existing sales staff locations as seed points to create
geographically balanced territories. Territories can be balanced
using multiple criteria to ensure optimal balance for each sales
person or franchisee. In the example at right, Territory Design was
used to create sales territories for a set of sales offices and
balanced with factors such as sales performance, household
counts and distance to eliminate gaps and ensure an appropriate
distribution of sales territories.

Balancing Territories

A map showing sales territories balanced by sales performance and
household counts.

A chart view of the map above showing how well sales performance (red
line) and household counts (blue line) have been balanced within each of
the territories.
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ABOUT TERRITORY DESIGN FOR ARCGIS 5

Territory Design includes many tools to manage your territories
from adding or removing variables in the balancing process to
exporting your database with your newly balanced territories to
organizing your territories in hierarchies so you can better
understand your market. Analyzing your territories starts first
with analyzing the markets your territories fall within, and this can
be displayed by creating higher levels of territories that collapse
down into your sales territories. These higher levels of territories
are typically used to further define your sales territories, and is
beneficial to see and analyze these distributions as well.

In the graphic below, Area represents your total market, each
Region represents a sales manager, and Territory represents the
territories your individual sales managers are responsible for.

With these hierarchies, you can a broader view of your market
and your regions to better determine how to increase the
marketability of your products. One easy way to do this is to

Managing Territories

export your regions as trade areas and analyze their
demographics in Business Analyst using its multitude of built-in
tools. With the trade area analysis tools in Business Analyst, you
can run demographic reports to compare and contrast your sales
against the base demographics in those areas such as household
counts, median household income, adult population, etc, and
create correlations between your sales output and the customer
base and sales potential in your market.
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6 USING TERRITORY DESIGN FOR ARCGIS

What to read next

To begin learning about how to use Territory Design, proceed to
Chapter 2, “Tutorial”. This section gives a step-by-step walk-
through of the process of creating, balancing, and analyzing
territories using the sample data provided.

For a detailed look at all the functionality of Territory Design
proceed to chapter 3, “Using the Territory Design toolbar”. In this
chapter, you be introduced to all the functionality and tools
associated with Territory Design.

ArcGIS Desktop Help

ArcGIS Desktop Help is available for Territory Design by
pressing F1 or clicking the Help menu, clicking Extensions,
clicking Business Analyst, then clicking Territory Design.

Getting help online

To browse the contents of ArcGIS Help Online, click the Help
menu and click ArcGIS Desktop Help Online. On this page you
can access the help by clicking the Extensions drop-down,
clicking Business Analyst, then clicking Territory Design. You
can also click the Business Analyst link under ArcGIS Extensions
and click Territory Design.

Visit the online ESRI Knowledge Base for access to Business
Analyst and Territory Design related product documentation,
white papers, and system requirements at
http://support.esri.com/knowledgebase.

Visit the online ESRI User Forums to share ideas and findings
with other users at http://support.esri.com/forums.

Getting additional help for Territory Design for ArcGIS

Getting technical support from ESRI

Please see the product registration and support card that came
with Business Analyst, or look at the ESRI Online Support Center
section of ArcGIS Help Online.

ESRI training and education

ESRI provides educational opportunities related to geographic
information science, GIS applications, and technology. You can
choose among instructor-led courses, Web-based courses, and
self-study workbooks to find education solutions that fit your
learning style. For more information, go to www.esri.com/
education.

Visit ESRI on the Web

Find out everything you want to know about ESRI software and
services. Visit ESRI’s Web site at www.esri.com.
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IN THIS CHAPTER

2
• Exercise 1: Creating a territory

layer

• Exercise 2: Creating and
balancing territories

• Exercise 3: Reassigning territories
and creating a territory report

Welcome to the Territory Design for ArcGIS tutorial. This chapter takes you
through the process of creating, balancing, and analyzing territories. When
you install ArcGIS Business Analyst, the Territory Design toolbar is also
installed. You will find sample data for this tutorial at \ArcGIS\Business
Analyst\Datasets\Tutorial\sales_locations.shp.

In this tutorial, you’re the VP of Metro Landscape, a major residential
landscape services firm in the Detroit, Michigan area. Your business is
rapidly growing, and you are in charge of overseeing the management of
each of the five branch locations. With the growing business and increasing
area population, problems have surfaced such as overlapping crews, uneven
sales at each office, and a decline of new contracts. Your goal is to work
with each of the five office managers to create new territories that will
define boundaries for sales and marketing efforts and establish consistent
service areas. Territory Design for ArcGIS can help you:

• Determine your market area.

• Locate your offices.

• Create and balance sales territories for each branch.

Here’s a chance to use Territory Design for ArcGIS as part of your
business solution.

Tutorial
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8 USING TERRITORY DESIGN FOR ARCGIS

Exercise 1: Creating a territory Layer

Having an alignment layer is the foundation to creating territories.
An alignment layer is a set of geographic boundaries, such as
census tracts, ZIP Codes, or counties, commonly containing
demographic information. Business Analyst provides many
different levels of alignment layers for use in Territory Design, but
you can also bring in your own data. With an alignment layer
selected, a territory layer can be created in ArcMap.

In this exercise, you will zoom to an area and create a territory
layer.

Getting started

1. Click Start, point to All Programs, point to ArcGIS, point to
Business Analyst, then click Business Analyst.mxd.

2. ArcMap starts, and the Business Analyst dialog box appears.
This dialog box gives you the option to turn off the Business

Analyst extension at startup. To do this, check the Turn off
the Business Analyst Extension check box and click OK.

To leave the extension turned on, click OK.

When turned on, this option automatically adjusts the
coordinate system of the data frame to a custom Business
Analyst projection whenever the map extent changes. If you
want to set and maintain a fixed coordinate system, turn off
the Business Analyst extension.

The Business Analyst dialog box appears again. Click OK to
close it.

3. The Business Analyst Assistant docks on the right side of
your screen. Review this tutorial to become familiar with the
different functions of Business Analyst. You can work with
the Assistant interactively, or if you are finished, click Close.

You are now ready to begin working with the map.

4. Click the File menu and click Save As to save your map
document under a new name. Navigate to C:\My Output Data
and create a new folder. Name the folder “TD Tutorial” and
save the map document as TD_Tutorial.mxd.

You will use both the Territory Design toolbar and the
Business Analyst toolbar in this tutorial. Make sure you have
both of them turned on and active in ArcMap.

To add the toolbars to ArcMap, click the View menu, point to
Toolbars, then check both the Business Analyst and Territory
Design check boxes. Make sure they are both checked on
under Tools > Extensions. These toolbars are both dockable,
meaning you can drag them anywhere on-screen or dock them
at the side, top, or bottom areas of the ArcMap window.
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TUTORIAL 9

Note: Check the Only show Business Analyst data layers (BDS)
check box to limit which layers are displayed. The alignment layer
forms the geographic building blocks for the sales territories. The
alignment layer must have a unique ID. Choose ID from the
alignment layer ID field drop-down list; this is already included in
the ZIP Code database.

4. Determine the number of territory levels in your hierarchy,
choose 2 from the drop-down menu. The levels are
automatically added as Territories and Regions below. You will
make a total of five sales territories nested within two regions.
Because territories are hierarchical, regions are created from
the underlying territories. In the size field, type “5” for
Territories and “2” for Regions, then click Next.

5. Choose the variables that determine how you balance your
territories. The variables become the attribute fields in your
territory layer. For this exercise, you want to focus on the
households in the Detroit area. In the Available variable(s)
window, click the + sign next to BA Fields to expand the
selection. Click <current year> Total Households add it to the
Selected variable(s) window by clicking the right arrow >
button. Make sure this is the only variable chosen, if General
Count is selected, remove it and click Next.

Zoom to a location and create a territory layer

Business Analyst provides you with predefined spatial
bookmarks that help you easily zoom to an area. You use these
bookmarks to get to our market area. Once you settle on an area
of interest, you can create a territory layer. When you create your
terrtory layer you set up the basic parameters needed to later
create and balance territories.

1. Click the Business Analyst drop-down menu and point to Set
Analysis Extent > Jump to a Location > States LA - MT >
Michigan > Detroit.

Business Analyst will zoom to the desired location, the
metropolitan Detroit area. You are now ready to create the
territory layer.

2. Click the Territory Design drop-down menu and click Active
Layer, then click Create Territory Layer. The Create New
Territory Layer wizard opens.

3. Choose ZIP Codes as your alignment layer.
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10 USING TERRITORY DESIGN FOR ARCGIS

Note: You can use as many variables as you want.

6. Type “Metro Landscape” in the New Territory Layer name text
box; give the New Territory Layer file path the following name:
C:\My Output Data\TD Tutorial\Metro Landscape; click Next.

7. Review the settings you applied and click Finish.

The territory layer you created includes ZIP Codes for the whole US.
Zoom into the Detroit area to see the alignment layer polygons.

8. In the table of contents, right-click Territories and choose
Open Attribute Table to examine the contents. Notice that the
<current year> Total Households field is added, but none of
the information is populated. The information is populated
when you create and balance the territories in the next
exercise. Close the table when you are finished.

9. Save your work. Click the File menu, then click Save.

Proceed to Exercise 2.

The territory layer is added to your table of contents. The
territory layer consists of the Territories and Regions levels
you specified and a copy of the alignment layer. Default
names (Territory 1, Territory 2, etc.) are used until you specify
territory names when creating territories.
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TUTORIAL 11

Exercise 2: Creating and balancing territories

Now that you have created a Territory layer, you are ready to
create territories. You can create territories using a variety of
methods, but for this tutorial, you will create territories from
locations. The locations, seed points, are starting points around
which territories are created. Seed points in this tutorial are your
Metro Landscape branch offices. These offices contain
equipment and are where all business activities are centered.

In this exercise, you will add seed points, create and balance
territories and regions, set the territory extent, and view your
regions in Edit Mode.

Add seed points

1. If you’ve exited ArcMap, click Start, point to Programs, point
to ArcGIS, then click ArcMap. The Business Analyst
extension dialog box opens. Click OK to close it, and the
Welcome to Business Analyst dialog box opens. Click An
existing map, click TD_Tutorial.mxd, and then click OK.

2. Click the Add Data button from the Standard toolbar and
navigate to \ArcGIS\Business Analyst\Datasets\Tutorial.

3. Locate sales_locations.shp and click Add.

A geographic projection warning will appear, click Close. The
shapefile is added to ArcMap in the table of contents and in
the map view. In the table of contents, right-click
sales_locations and choose Open Attribute Table. The
attribute table contains information such as the office city
location, the office manager and his/her employee ID, and the
manager’s yearly sales volume to date. Close the table when
finished.

Create territories

1. Click the Create Territories button on the Territory Design
toolbar.

2. Choose Metro Landscape from the Territory layer drop-down
list.

3. Click Create territories from locations and click Next.

4. Choose Territories from the Territory level to create drop-
down list.

5. Choose sales_locations from the Point layer drop-down list.

6. Choose NAME from the Attribute for naming territories drop-
down list. These names will replace the default names in your
territory layer currently in the table of contents.

7. Choose Territories from the Territory level to create drop-
down list. Be sure the number of territories to be created from
seed points text box is “5”, click Next. You will later create
Regions as well.
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12 USING TERRITORY DESIGN FOR ARCGIS

8. This dialog box focuses on how distance is measured from
your seed points to your territories. To maximize efficiency,
you know that your fleet should never travel beyond 40 miles
from each office. For Distance type, choose Straight line
distance from the drop-down list and make sure the distance
units are measured in miles. Type “40” in the text box provided
for Maximum distance that a territory is away from its seed
point. This will ensure each territory boundary is limited to 40
miles from each office. Leave the Minimum distance that a
territory is away from another seed point box unchecked.
Choose Centroid of geography element in the Distance is
measured to drop-down list and click Next.

9. Check Balance territories and click Next. The Balancing
Options dialog box appears.

Note: Unbalanced territories are created if you do not choose to
balance territories first.

10. You now want to choose the variables that will determine how
your territories are balanced. The Available variable(s)
window represents fields in the alignment layer. Since
residential properties are your core clientele, you want to
make sure that each territory you assign contains an equal
number of households. Choose the <current year> Total
Households and add it to the Balancing variables window
using the right arrow > button. Click Next.
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TUTORIAL 13

11. You want to make sure total households is more of a factor in
the balancing method. The default variable ratio is set to 50,
but you can change the importance dynamically using the pie
chart. Click and drag the pie chart separator lines until you
have reached 75 for <current year>Total Households Sum, 25
Distance. Click Next.

Note: you can manually edit the variable preference, but the
values must total 100.

12. Check the boxes for Territories must be contiguous and No
holes inside territories and click Next. This will ensure there
are no gaps between ZIP Codes.

13. Review the settings you applied and click Finish. Your
territories have been created, and the names of each office
manager have been assigned to their respective territories.

Set the territory extent

1. Now that you have defined your market area, you can set a
territory extent to ensure only that area is used in your
analysis. Click the Territory Design drop-down menu and click
Territory Extent. The Territory Extent wizard opens.

2. Choose Metro Landscape from the Territory layer drop-down
list and choose Boundary of a layer, then click Next. Choose
Territories from the drop-down list and click Finish. Territory
Design will draw a thick border around your territories to
define the outermost boundary of your analysis. Zoom out
once so that all of your territories are in view.

The territories you created should look similar to the territories shown
in the map above. There are many default territory colors so the
territories you create may be slightly different.
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14 USING TERRITORY DESIGN FOR ARCGIS

Create regions

Creating regions requires many of the same steps as creating
territories, except you are creating a higher level to which the
underlying territories belong.

1. Click the Territory Design drop-down menu and click Create
Territories.

2. Choose Metro Landscape from the Territory layer drop-down
menu list

3. Choose Create territories from locations and click Next.

4. Choose Regions from the Territory level to create drop-down
list.

5. Choose sales_locations from the Point layer drop-down list.

6. Choose CITY from the Attribute for naming territories drop-
down list. These names will replace the default names in your
region layer currently in the table of contents. You have
chosen CITY as the name because these locations will divide
the two main command centers for all territories.

7. Choose Regions from the Territory level to create drop-down
list and type “2” in the Number of territories to be created
from seed points text box. Click Next.

8. Choose Straight line distance from the Distance type drop-
down list and make sure the distance units are measured in
miles. Type “200” in the text box for Maximum distance that a
territory is away from its seed point. This ensures all
territories within the territory extent are included. Choose
Centroid of geography element from the Distance is
measured to drop-down list and click Next.

9. Check Balance territories and click Next. The Balancing
Options dialog appears. The <current year> Total
Households variable should remain selected; if not, add it to
the Balancing variable(s) window using the right arrow >
button. Click Next.

10. To remain consistent with the underlying territories, click and
drag the pie chart separator lines until you have reached 75
for Total Households, 25 for Distance. Click Next.

11. Check the boxes for both Territories must be contiguous and
No holes inside territories and click Next.

12. Review the settings you applied and click Finish. Your
regions have been created, and the city locations (Ann Arbor
and Clinton Twnsp) have been assigned to each region.
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TUTORIAL 15

View your regions in Edit Mode

Using Edit Mode will increase the thickness of your region
outlines and temporarily make the underlying territories
invisible. Edit Mode makes multiple levels of territories easily
distinguishable without having to turn layers on or off in your
table of contents.

1. Choose Regions from the territory level drop-down list located
on the right side of the Territory Design toolbar.

2. Click the On/Off Edit Mode button on the Territory Design
toolbar. The Ann Arbor and Clinton Twnsp regions are
separated by color.

3. Click the On/Off Edit Mode button on the Territory Design
toolbar to exit Edit Mode and show territories again.

4. Save your work. Click the File menu, then click Save. Proceed
to Exercise 3.
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16 USING TERRITORY DESIGN FOR ARCGIS

Exercise 3: Reassign territories and create a territory report

In previous exercises you created a territory layer, brought in
seed points, and created and balanced territories and regions.
You are now ready to determine how well you balanced your
territories and manually reassign them. Then you can create a
report to output the information about your territories.

In this exercise, you will examine the Territory Design window,
manually reassign territories, and create a territory report.

View the Territory Design window

1. If you’ve exited ArcMap, click Start, point to Programs, point
to ArcGIS, then click ArcMap. The Business Analyst
extension dialog box opens. Click OK to close it, and the
Welcome to Business Analyst dialog box opens. Click An
existing map, click TD_Tutorial.mxd, then click OK.

The Business Analyst Extension dialog box opens again; click
OK to close it.The Business Analyst Assistant opens; close it
if you’ve already reviewed the tutorial.

2. Click the Show/Hide TD Window button on the Territory
Design toolbar.

The Territory Design Window opens at the bottom of the
screen. The TD window is dockable so you can resize and
move it to other locations within ArcMap if necessary. You are
now ready to view the TD Window. Notice that the window is
separated into two panes: the Data and Hierachy tabs on the
left side and the Statistics and Chart tabs on the right. You will
focus on the Data and Chart tabs first, then examine the
Hierarchy tab.

3. Click the Data tab. The data view shows which attributes are
included in each level of your analysis. Choose Metro
Landscape as the Territory layer and click Territories from the
Territory drop-down list. Click the <current year> Total
Households field header to sort ascending and descending.
Doing this shows the different ZIP Codes with the highest
and lowest number of households assigned to each territory.
You can right-click any data record to view the different data
management options available, such as Zoom to Territory or
Remove Territory.
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TUTORIAL 17

4. Click the Chart tab. The chart view is a visual guide to how
well territories are balanced. A balancing line is included to
show the mean value of a selected variable for all territories.
The chart shows all five territories by name. They appear to
be equally balanced by total households.

5. On the left pane, click the Hierarchy tab. The hierarchy view
shows a graphic tree view of your territory levels. Expand the
two regions to see their respective territories. The numbers in
parentheses next to the territory names are the number of ZIP
Codes in each territory. The numbers in parentheses next to
the region names represent the count of territories in each
region. Click on a region name to see the chart view change to
show region information. You see two bars instead of five.
Click any territory name to return the chart view to the
territory information. Your territories seem to be fairly equally
balanced, but you notice that Mr. Richard is covering a rural
area and his sales numbers have been low over the past year.
You will now manually reassign more ZIP Codes to increase
his territory area.

6. Click the Territory Select Tool from the Territory Design
toolbar and click a ZIP Code assigned to Howe in the map.

7. Right-click the selected ZIP Code and point to Reassign To
Territories at the bottom of the context menu, then choose
Richard.

You can see that the ZIP Code has been added to Richard’s
territory in the map view and on the chart. In the chart view
the number of households in his column is more than the
average level. Reassign a few more territories using the same
process. The Territories balance chart and data is updated to
reflect this change.
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18 USING TERRITORY DESIGN FOR ARCGIS

Create a territory report

1. Click the Territory Design drop-down menu and click Territory
Report. The Territory Report dialog box opens.

2. Type a name for your territory report.

3. Make sure Metro Landscape is selected in the Territory Layer
drop-down list and click OK. A report opens onscreen
showing a map, balancing chart, and hierarchy of your
territories and regions. You can export the file to PDF to share
with your office managers.

Now that you’ve completed all the tasks in the tutorial, you have
a good idea of what’s involved with using Territory Design for
ArcGIS from creating and balancing territories to reassigning
them and creating reports. Continue reading to learn about other
things you can do with Territory Design or, if you prefer, use this
guide as a reference, reading the specific sections you need to
complete your tasks.
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IN THIS CHAPTER

• Using the Territory Design toolbar

• Setting the Territory Extent

• Creating New Territory Layers

• Creating New Territories

• Using the Balancing Options and
Balancing Territories wizards

• Resolving Overlapped Territories

• Importing Variables and Removing
Variables

• Exporting Territories

• Creating a Territory Report

• Using the Territory Design Window

• Working in Selection Mode and
Edit Mode

• Setting the Territory Layer Proper-
ties

In this chapter, you will learn about the different functions of Territory
Design for ArcGIS.

The Territory Design toolbar utilizes a drop-down menu and a wizard driven
interface similar to the other tools in the Business Analyst extension. Many
features of the two programs are interchangeable. For example you can use
ZIP Codes found in Business Analyst to serve as a base layer for creating
trade areas in Territory Design. Or you can export a Territory Design layer
to Business Analyst to further study demographic information of newly
created sales territories. All Territory Design features can be accessed from
the toolbar or drop-down menu. This section gives step-by-step instructions
for each Territory Design tool.

Using the Territory Design toolbar 3
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20 USING TERRITORY DESIGN FOR ARCGIS

Using the Territory Design toolbar

Territory Design toolbar drop-down menu

If the Territory Design toolbar is not visible, click the View menu,
click Toolbars, then click Territory Design. The dockable toolbar
opens.

Territory Extent—Allows you to set different analysis extents
such as the current map view, a selected boundary, or none
defined

Active Layer—Allows you to make a different territory layer the
active territory layer, as well as create a new territory layer

Create Territories—Launches the Create New Territories wizard
to create new territories

Remove Territory—Allows you to quickly remove previously
created territories

Balance Territories—Allows you to balance territories based on
multiple criteria

Balancing Options—Launches the Balancing Options wizard to
setup or alter the variables and associated weights used in the
balancing process

Resolve Overlapped Territories—Allows you to view duplicate
territory assignments and resolve their locations

Import Variables—Launches the Import Variables wizard to add
attribute information from another database or location to a
territory layer

Remove Variables—Allows you to delete attributes previously
imported to a territory layer

Refresh Imported Variables—Allows you to reimport variables if
a joined database is changed

Export Territories—Launches the Export Territories wizard to
export territory databases and boundaries for use outside
Territory Design

Territory Report—Launches the Territory Report wizard to run
reports on your territories

Show/Hide TD Window—Launches the Territory Design window
to manage layers and view statistics and chart information about
your territories

Selection Mode—Allows you to view elements of selected
territory features

Edit Mode—Allows you to view and work with the active territory
level

Territory Layer Properties—Allows you to view or make
changes to a variety of Territory Design settings

Territory Select Tool—Allows you to select elements on the map
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1. Click Territory Extent from the
Territory Design drop-down
menu.

The Territory Design Extent
dialog box opens.

2. Choose the territory layer
you want to use from the
Territory layer drop-down list.

3. Choose one of the options
and click Finish.

If you choose Business
Analyst study area, choose
the study area you want from
the drop-down list and click
Finish.

If you choose Boundary of a
layer, click Next. Choose the
boundary layer you want
from the drop-down list and
click Finish.

Setting the
Territory Extent
Setting the territory extent will
ensure that your analysis will
include only the areas you
specify. This extent determines
your overall market area. If you
do not set a territory extent,
territories will be created for the
entire layer you are working
with. The additional processing
can be time consuming.

You must create a Territory
Layer before being able to set
the Territory Extent.

Tip
You can set different extents to limit
where your analysis is performed.

Current map view: Limits the
analysis to the area currently on
your screen

Current selection: Limits the
analysis to areas you have selected,
such as a group of ZIP Codes

Business Analyst study area: Limits
the analysis to areas you have
predefined in Business Analyst

Boundary of layer: Limits the
analysis to the overall boundary of
a polygon or group of polygons

No extent defined: Removes the
analysis extent from your analysis
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Creating New Territory Layers

Territory layers must be set up first to perform an analysis in
Territory Design for ArcGIS. By creating a territory layer you set
important parameters such as your alignment layer (for example,
ZIP Codes or block groups), hierarchy levels, and the number of
territories. You also determine what variables are needed to later
balance your territories. Once you have successfully set up
your Territory Layer, it will be added to the map’s table of
contents as a layer with an empty attribute table. When you
create and balance your territories, the attribute information is
automatically populated. This section teaches the various
options for creating territory layers.

Here is some important information about territory layers.

• As a starting point Territory Design calls the first four levels
Territories, Regions, Areas, and Divisions. These are standard
terms for territory hierarchy. The remaining levels are named by
level (such as Level 5, Level 6) You can set up to 10 territory
levels and have the option to customize the level names to
whatever you choose.

• You can use the standard geography boundaries provided in
Business Analyst to create territories or use your own polygon
layers. These boundaries are alignment layers.

• If you use your own boundaries, each polygon must have a
unique ID and name associated with it.
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Creating a New
Territory Layer
Territory layers must be set up
first to perform analysis in
Territory Design for ArcGIS.
These steps will give you
instructions on how to set up a
territory layer.

1. Select Create Territory Layer
on the Territory Design
toolbar.

The Create New Territory
Layer dialog box opens.

2. Choose an alignment layer
from the Alignment layer
drop-down list..

3. Choose the Alignment layer
ID field from the drop-down
list. This field must be a
unique ID.

4. Determine how many
territory levels you want to
create using the drop-down
list.

5. Rename your territory levels
as needed and enter the size
of each level. Click Next.

6. Add the variables of each
level that determine your
balancing and click Next.
These variables make up the
fields in your territory
databases. u

Tip
The alignment layer must have a
unique ID. The alignment layer
serves as the base geography layer
from which all territories are
created.

Tip
The New Territory Layer file path
is the location where your Territory
Design analyses are stored. By
default the path is set to your My
Output Data folder, but you can
choose any location.

Tip
When creating a new territory
layer, a copy of your alignment
layer is created as well. The copy is
made so your original data is not
altered. The alignment layer copy is
added to the table of contents
underneath your new territory
layer.
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7. Type a name in the New
Territory Layer name text box.
Set the file path workspace
and click Next.

8. Review the settings that will
be applied to the new
territory layer, click Finish.
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Creating New Territories

Properly allocated territories are a key component of any
successful business. With Territory Design you can setup,
modify, and manage territories in a variety of ways. You may
have created stagnant territories years ago that you want to
reexamine or start fresh with no inherent knowledge of your
company’s newly acquired region. You might want to base your
territories from franchise or customer locations. You might have
a simple list of sales people and their accounts by location.
These are all scenarios you can solve with Territory Design.
This section teaches the various options for creating territories.

Territory creation options

Creating new empty territories: This option can be used to add
territories to a previously created Territory Layer. The new
territories will update in the table of contents.

Creating territories from locations: This option can be used
when you have a point layer with unique locations, called seed
points.

Importing territories from a database: This option can be used
if you have a territory layer table format such as a .dbf. This
dialog will help you map the appropriate fields to ensure it is
importing into each territory level correctly.

Seed points

Seed Points are point locations used in Territory Design to
determine starting points for creating territories. Seed points can
be anything from franchise addresses and sales offices to
distribution centers and are a common method for creating
territories. For example, if you have a set of salespeople in
offices around the Greater Chicago area, you can use this option

to create and balance their respective sales territories using
census tracts around each location.

The seed point locations can be any point file with geographic
information tied to it. Territory Design uses the locations to
determine the geographic centers for the creation of the territo-
ries. If you are creating fewer territories than the number of seed
points, Territory Design uses clusters of your seed points as the
geographic center for each territory.

About the Number of territories to be created from seed
points option

• The default number of territories is equal to the number of
territories at the level where you create new territories. If the
level where you create new territories is empty, the default
number of territories is equal to the number of geographic
elements from the alignment layer overlapped by the seed
points.

• If the number of territories is equal to the number of geo-
graphic elements in the alignment layer that overlap the seed
points, territories are created for each geographic element of the
alignment layer where the seed points are located.

• If the number of territories specified is greater than the number
of geographic elements from the alignment layer overlapped by
the seed points, all seed points are used to create territories and
the remaining number of territories are created from the nearest
geographic elements of the base layer.

• If there are fewer territories than the number of geographic
elements overlapped with seed points, Territory Design uses
clusters of your seed points as the geographic centers for each
territory.
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Creating new empty
territories

1. Click the Territory Design
drop-down menu and click
Create Territories.

The Create Territories dialog
box opens.

2. Choose the territory layer
you want to use from the
drop-down list.

3. Choose Create new empty
territory and click Next

4. Choose the Territory level to
create from the drop-down
list.

5. Type the number of territories
you want to add.

The new territory is added to
the table of contents.

Creating New
Territories
Creating new empty territories

This option can be used to add
territories to a previously
created Territory Layer. The
new territories will be added to
the table of contents.

Tip
You must create a new territory
layer before before creating
territories (see “Creating new
territory layers” in this chapter).
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Creating New
Territories
Creating territories from
locations

The option can be used when
you have a point layer with
unique locations, seed points,
around which you want to
assign territories.

Creating territories from
locations

1. Click the Territory Design
drop-down menu and click
Create Territories.

The Create Territories dialog
box opens.

2. Choose the territory layer
you want to use from the
drop-down list.

3. Choose Create territories
and from locations, click
Next.

4. Choose the territory level you
want to create from the drop-
down list.

5. Choose the point layer from
the drop-down list (or click
the browse button to navi-
gate to it if it is not in the table
of contents) to determine
which seed point locations
will build your territories.

6. Choose the attribute to name
each territory.

7. Type the number of territories
you want to create and click
Next. u
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8. Set the distance require-
ments for your territories:

Choose the Distance type
(Straight line distance, Drive
distance, or Drive time) and
corresponding distance units
from the drop-down lists.

9. Set the maximum distance a
territory can be from its seed
point.

You can also choose to set
the minimum distance a
territory is from another seed
point.

10.Choose whether distance is
measured to the centroid of
each geography element or
to the nearest boundary of
the geography element. Click
Next.

To create territories without
balancing them, click Next.
Unbalanced territories are
created after you review your
settings and click Finish.

To balanced territories now,
check Balance territories and
click Next. The Balancing
Options dialog box will open.
To complete these steps,
continue to “Using the
Balancing Options and
Balance Territories wizards”,
step 8.

Tip

Measuring Distance

Centroid of a geography element
refers to the distance between a seed
point location and the geographic
centroid of a polygon (such as ZIP
Codes).

Nearest boundary of geography
element refers to the distance
between a seed point location and
the  edge of a polygon boundary
closest to that seed point.

Tip
For the Number of territories to be
created from seed points option the
default is the number of territories
you specified when creating your
territory layer. You can also have
more seed points than territories.
For example, if you have 60
different franchise locations, but
only want to show 8 territories,
Territory Design groups the seed
points into clusters to determine the
center point for each of the 8
territories.

Tip
The Drive distance and Drive time
options are only available when the
Business Analyst and ArcGIS
Network Analyst extensions are
installed.
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Create New
Territories
Importing territories from
database

The option can be used if you
have a territory layer table such
as a .dbf file. This dialog box
will help you map the appropri-
ate fields to ensure it is import-
ing into each territory level
correctly. An example of this
would be that organizations
may have a set of ZIP Codes
assigned to salespeople. These
ZIP Codes can be imported into
Territory Design as sales
territories. Once you have the
data in Territory Design, further
analysis can be performed.

Importing territories from
a database

1. Click the Territory Design
drop-down menu and click
Create Territories.

The Create New Territories
dialog box opens.

2. Choose Import territories
from databaseand click Next.

3. Choose the database file
from which you are importing
your territories from the drop-
down list or by clicking the
browse button to navigate to
it.

4. Choose the number of
territory levels.

5. Choose the database fields
for each territory level.

Click the attributes to change
ID fields if needed. Click
Finish.
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Using the Balancing Options and Balance Territories wizards

A powerful aspect of Territory Design for ArcGIS is its territory-
balancing capabilities. Balancing sales territories, service areas,
or franchise boundaries is a key component to any successful
business. With Territory Design, it is possible to balance areas
based on multiple factors such as the size of each territory, the
projected sales figures across your region, or the distance
traveled between each store.

The two main components of balancing are the Balancing
Options and Balance Territories wizards. Balancing Options is
used to set up the parameters for how a particular territory
should be balanced. For instance, you can choose ZIP Code
Population and Sales Revenue Per Store Location as variables
and allocate more importance to whichever variable should have
a greater weight in determining the makeup of your territories.
Once the balancing options are finalized the Balance Territories
wizard is used to apply the parameters to your territories. This
section provides insight into balancing territories using Terri-
tory Design.
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1. Click the Territory Design
drop-down menu and lick
Balancing Options.

The Balancing Options
wizard opens.

2. If you have already created a
territory layer, choose the
Territory Layer you want to
want to work with from the
drop-down list.

3. Choose the level you want
balance and click Next.

4. If you are balancing territo-
ries with seed points, check
the Use seed points box and
choose the point layer from
the drop-down list..

 Check the Do not reassign
polygons that contain seed
points check box if you do not
want polygons that overlap
seed points to change. u

Setting Balancing
Options and
Balance
Territories
parameters
This section provides instruc-
tion on how to balance territo-
ries. Before proceeding with
this section it is assumed you
already created a territory layer
and created territories.

Tip
Checking the do not reassign
polygons that contain seed points
check box will ensure that the
polygons where seed point
locations overlap are not changed
to another territory. This is
especially important when you have
more seed points than the territo-
ries.
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5. Set the distance require-
ments for your territories:

Choose the distance type
(Straight line, Drive distance,
or Drive time) and corre-
sponding Distance units from
the drop-down lists.

6. Set the maximum distance a
territory can be from its center
or seed point.

You can also choose to set
the minimum distance a
territory is from seed points.

7. Choose whether distance is
measured to the centroid of
each geography element or
to the nearest boundary of
the geography element. Click
Next. u

Tip

Measuring Distance
Centroid of a geography element
refers to the distance between the
center of a territory or seed point
location (if specified) and the edge
of a polygon boundary closest to
that seed point.

Nearest boundary of geography
element refers to the distance
between the center of a territory or
seed point location (if specified)
and the edge of a polygon bound-
ary closest to that seed point.
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8. Add the balancing variables
that will weight your areas
and click Next.

You can bring in other
variables by clicking Import
Variable. For more informa-
tion, see “Importing variables
and removing variables” later
in this chapter.

9. Determine the importance
each variable has toward
balancing the territories.

To do this, under the Prefer-
ence(%) column, type the
percentage or drag the pie
chart lines to the left or right.
Click Next. u

Tip

Using the preferences pie
chart
By default, all variables are
weighted equally. The pie chart is a
way to change the variable
importance of the territories you
are creating. Click and drag the
separator lines to dynamically
change the percentages. The
numbers will automatically change
in the field view. The percentage
must total 100. The distance weight
is a significant factor in the
development of territories. If you
want to balance your territories
based on an attribute, such as
sales, make sure you minimize the
distance weight in the pie chart.

For example, you are a cable TV
provider looking to redistrict your
franchise areas, which are based
on ZIP Codes. You know that
having an equal population
distribution is key to adequately
support your customer base, but
you also know that as long as you
have enough technicians on hand,
the size of the area is not relevant.
In this case, you may want to set
the population importance variable
at a higher percentage and leave
the distance factor low. This will
increase the probability that the
underlying ZIP Codes will be
combined to form weighted
territories with equal population.

Tip
You can use the available fields
filter to quickly find a variable to
balance.
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Tip

Geographic Balancing
Options
Territories must be contiguous:
Checking this option ensures that
all geographic objects adjacent to
balanced territories are included in
balancing.

No holes inside territories:
Checking this option ensures that
the balancing algorithm does not
create blank areas wholly con-
tained inside territories. Any
unassigned elements are appended
to the surrounding territory. The
balancing algorithm does not
remove holes that were present
before starting the Balance
command.

Use unassigned territories:
Checking this option ensures that
currently unassigned geographic
elements are added to territories to
improve the balance. Uncheck this
option if you only want to swap
geographic elements between
territories.

Tip

Balancing Territories
You should set  your parameters on
the Balancing Options wizard
before choosing to balance
territories. When you choose to
balance territories, you are
applying the parameters set on the
Balancing Options wizard.

If you are trying to balance a set of
unassigned geographic elements
(eg, ZIP Codes, census tracts) into
territories, you must first create
territories.

10.Check the boxes for geo-
graphic options for balancing
territories and click Next.

11.Review the settings that will
be applied and click Finish.

The Balancing Options
dialog box closes. With the
balancing options set, you
are now ready to balance
territories. u
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12.Click the Territory Design
menu and click Balance
Territories.

The Balance Territories
dialog box opens.

13.Choose the territory layer
you want to work with from
the drop-down list.

14.Choose the territory level you
want to balance and click
OK.

The attribute table and map
are updated based on the
balancing options you have
set.
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1. Click the Territory Design
drop-down menu and choose
Resolve Overlapped Territo-
ries.

The Resolve Overlapped
Territories dialog box opens.

2. Choose the territory layer
you want to use from the
drop-down list.

3. Only one box under the
Overlapped territories
column correspoing to the
Concurrent elements column
should be checked to ensure
territories are not overlapped.
Check only the boxes where
territories belong to concur-
rent elements.

Tip
The overlapping of territories is
supported only at the alignment
layer level.

Territories can be created to
overlap each other by importing
territories, from a selection on the
map, and by copying/pasting.

Within the Resolve Overlapped
Territories dialog box, Concurrent
elements refers to territories at
each hierarchy level that belong to
more than one territory at the
higher level. The Overlapped
territories listing contains upper-
level territories, which incorporate
currently selected unresolved
territories. You can check on/off the
upper-level territories to resolve
the overlapping.

Resolving
overlapped
territories
It is possible that more than one
territory can contain the same
unique element. For example,
one ZIP Code could belong to
two different territories.
Territory Design provides the
Resolve Overlapped Territories
utility to solve this.

Tip
If you have overlapped territories,
they will appear in the table of
contents as a new layer. Over-
lapped territories appear hatched
in the map.
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Importing Variables

1. Click the Territory Design
drop-down menu and click
Import Variables.

The Import Variables wizard
opens.

2. Choose the input feature
class or table you want to
import from the drop-down
list or click the browse button
to navigate to it.

3. Select the territory layer you
want to import the variables
to.

4. Choose the database join
method.

a. If you choose Join by
attribute, do the following:

• Choose the alignment
layer field you want to
join from the drop-down
list.

• Choose the input table
field you want to join from
the drop-down list and
click Next.

b. If you choose Join by
locations, click the button
and click Next.

5. Choose the variables you
want to import to the territo-
ries and use the right-facing
arrows to add them.

6. Confirm the settings that will
be applied and click Finish.

Tip
You can import point or polygon
layers to Territory Design. When
you choose a polygon layer and
click Join by locations, the values
to the imported variables are
divided in proportion of the
imported polygons that overlap the
polygons of the alignment layer.

You can also import a Business
Analyst Dataset (BDS). The
Business Analyst apportionment
method is used to calculate the
values of the imported variables.

Importing
variables and
removing
variables
Territory Design provides
options to bring new attributes
into an existing territory layer.
For example, you may want to
join newly compiled sales
figures before readjusting your
company territories. Once you
bring in selected variables, you
can refine the list using the
Remove Variables dialog box.

Tip
Refresh Imported Variables
reimports variables from joined
databases.
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Tip
Choosing to remove variables will
remove the joins between the
external tables of the imported
variable and the territory database.
It is assumed you have already
imported variables before choosing
to remove them. Note: If you move
your joined external table, the join
will be broken and you will not be
able to access the imported
attributes in Territory Design.

Tip
The performance of the balancing
operations can be reduced when
imported variables are present.

Removing Variables

1. Click the Territory Design
drop-down menu and click
Remove Variables.

The Remove Variables dialog
box opens.

2. Choose the variables you
want to remove by clicking
the right arrows. Click OK.

The variables are removed
from the territory database.
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Exporting
territories
Territory Design provides
multiple options to export your
territories for analysis in other
programs. For example, you can
create a set of territories in
Territory Design, then export
them for use in Business
Analyst.

Tip
Exporting territories as trade areas
allows Business Analyst to read the
territory polygons within the Trade
Area wizard. You can then use
these trade areas in subsequent
reports and analysis in Business
Analyst.

Exporting territories to
Business Analyst Trade
Areas

1. Click the Territory Design
drop-down menu and click
Export Territories.

The Export Territories wizard
opens.

2. Click Export territories to
Business Analyst Trade
Areas and click Next.

3. Choose the territory level or
individual territories you want
to export from the drop-down
list.

4. Give the trade area a name.

5. Review the settings that will
be applied.

6. Click Finish.
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Tip
You can export your territory
database to the following formats:

- dBASE Tables

- File and personal geodatabase
tables

- SDE tables

Exporting a territory
database

1. Click the Territory Design
drop-down menu and click
Export Territories.

The Export Territories wizard
opens.

2. Click Export territories
database and click Next.

3. Click the browse button to
navigate to a location where
you want to save the file.
Name your file and click
Save.

4. Click Finish.

Exporting a territory database
creates a territory assignment
table. The assignment table
contains names and unique IDs
for each hierarchy level, such as
Territories, Regions, and Areas.
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Exporting both territory
database and alignment
layer records

1. Click the Territory Design
drop-down menu and click
Export Territories.

The Export Territories wizard
opens.

2. Click Export territory data-
base and alignment layer
records and click Next.

3. Add the variables you want to
export by clicking the right
arrows and click Next.

4. Click the browse button to
navigate to a location where
you want to save the file.
Name your file and click
Save. Click Next.

5. Review the settings that will
be applied.

6. Click Finish.

Tip
You can export your territory
database and alignment records to
the following formats:

- Shapefile

- File and personal geodatabase
tables

- SDE tables

Tip
Exporting the territory alignment
layer is helpful, especially if you
have joined attributes from another
database. The exported file shows
the selected variables from both the
original database and the exter-
nally joined table.
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Tip
You can export your territory
database and alignment records to
the following formats:

- Shapefile

- File and Personal Geodatabase
tables

- SDE tables

Tip
By exporting the territory level and
corresponding variables, you have
the option to select any of the
summarized fields including Sum,
Max, Min, Average, Median,
Standard Deviation, and Percent of
Total. These summarized fields
represent the apportioned data
within a territory boundary. For
example, if you export a territory
layer created from ZIP Codes and
select Sum for a population
variable, Territory Design will
export the boundary of the territory
with the aggregated total popula-
tion within the ZIP Codes that
make up the new territory.

Exporting territory
boundaries and
variables

1. Click the Territory Design
drop-down menu and click
Export Territories.

The Export Territories wizard
opens.

2. Click Export territory bound-
aries and variables and click
Next.

3. Choose the territory level to
export from the drop-down
list.

4. Add the variables you want to
export by clicking the right
arrows and click Next.

5. Click the browse button to
navigate to a location where
you want to save the file.
Name your file and click
Save. Click Next.

6. Review the settings that will
be applied.

7. Click Finish.
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1. Click the Territory Design
drop-down menu and click
Territory Report.

The Territory Report dialog
box opens.

2. Type name for your territory
report in the text box pro-
vided.

3. Choose the territory layer you
want to report on from the
drop-down list and click OK.

The Territory Report is
displayed on screen.

Creating a
territory report
You can generate a report
showing the main elements of
creating territories. This
document serves as a summary
for the work you have done to
create and balance your
territories. The territory report
is accessed through the Crystal
Reports viewer, but you can
export to various formats such
as PDF, Word, or HTML.

The territory report includes the
following information:

• Hierarchy of territories

• Map of territories

• Territory variable statistics

• Chart view of territory
statistics
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Territory Design Window

The Territory Design window is the central location for viewing
your territory information and adjusting properties. The window
is dockable and is divided into two main panes. The first pane
contains two views, Data and Hierarchy. The second pane also
contains two views, Statistics and Chart. The window can be
accessed from the Territory Design toolbar and is designed to

Data view

Hierarchy
view

Statistics
view

Chart view

Territory Design window

be interactive as you perform your analysis within Territory
Design. The different views will help show how well your
territories are balanced. You can customize the window using
the options in the Territory Layer Properties dialog box. Since
the window is dockable, it can be resized and move it to different
parts of the screen. This section explains the different parts of
the Territory Design window.

Balancing line

Territory layer

Alignment layer

Resize the window pane
up or down hereClick and hold here

to dock the window
elsewhere

Territory Design toolbar

Active territory layer

Resize the TD window
pane left or right here
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Working in data view

1. Click Show/Hide TD Window
from the Territory Design
toolbar.

The Territory Design window
opens. Dock it as necessary.

2. Click the Data tab.

3. Choose the Territory layer
you want to work with from
the Territory layer drop-down
list.

4. Choose the territory level you
want to work with from the
Territory drop-down list.

The territory attributes are
displayed in the data window.

Territory Design
Window:

Data view
The data view is a table view of
objects that make up your
territories. The data view is
synchronized with the hierarchy
view. The territory layer and
selected territories are applied
in both views. You can perform
many behind-the-scenes
analysis in the data view.

Tips
- You can sort fields in ascending
or descending order by clicking
any of the attribute field headers.

- You can add more attribute fields
to the data view by opening the
Territory Layer Properties dialog
box, and choosing from the
available variables.

- You can quickly reassign
territories by clicking a field under
Territory. The Territory drop-down
list allows you to select other
territories.

- Right-clicking a Territory field
provides many different territory
management options.

- Double-clicking any data record
zooms to that element on the map.

- Selection of multiple territories is
supported in the data view by
holding down the Shift or Ctrl key
and clicking fields.
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Territory Design
Window:

Hierarchy view
The Hierarchy view is a
graphical view of your territory
levels. The hierarchy view of
territories is displayed in a tree
view. The Hierarchy view is
synchronized with the Data
view.

Tips
- Each geographic element contains
sub-objects when applicable. For
example, lower territories are
connected to their higher regions in
a tree view.

- You can drag and drop lower-
level elements to higher categories.
For example, you can move a
territory assigned to Region 1 into
Region 2.

- Right-clicking any geographic
element provides many different
territory management options.

- Double-clicking any geographic
element record in the hierarchy
view zooms to that element on the
map.

- Double-clicking the territory
symbols (colored rectangles) opens
the standard ArcGIS Symbol
Selector dialog box. Right-clicking
the territory symbols will open the
ArcGIS Color Pick dialog box.

Working in hierarchy
view

1. Click Show/Hide TD Window
from the Territory Design
toolbar.

The Territory Design window
opens. Dock it as necessary.

2. Click the Hierarchy tab.

3. Choose the Territory layer
you want to work with from
the Territory layer drop-down
menu.

All geographic elements of
the territory layer are shown
in the hierarchy window.
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Working in statistics
view

1. Click Show/Hide TD Window
from the Territory Design
toolbar.

The Territory Design window
opens. Dock it as necessary.

2. Click the Statistics tab.

3. Choose the territory level you
want to work with from the
Territories Level drop-down
list.

The statistics for the selected
geographic elements are
displayed.

Territory Design
Window:

Statistics view
The Statistics view displays the
statistics for selected levels of
your territory hierarchy. The
available statistics are summari-
zations of the territory attribute
fields.

Tips
- Statistics are shown as count,
sum, min, max, average, median,
standard deviation, and balance
index. The balance index indicates
how close the created territories
are to the parameters defined in the
Balancing Options dialog box.

- You can add more statistic fields
to the statistics view by opening the
Territory Layer Properties, and
choosing from the available
variables for each territory level.
Clicking +/- expands or collapses
your territory level tree views.

- You can view statistics by overall
territory level or individual
geographic elements by choosing
the desired layer from the Territo-
ries Level drop-down menu.

- Right-clicking any place in the
statistics view and clicking
“Statistics...” opens the standard
ArcGIS Statistics dialog box.
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Working in chart view

1. Click Show/Hide TD Window
from the Territory Design
toolbar.

The Territory Design window
opens. Dock it as necessary.

2. Click the Chart tab.

The contents of the chart
view are controlled by what is
selected in the Territory layer
drop-down list of the data or
hierarchy views or by the
current level selected on the
drop-down list on the TD
toolbar (not the Territory
Design drop-down menu, but
the hierarchy level drop-
down list on the right side of
the toolbar).

Territory Design
Window:

Chart view
The chart view displays
balancing information for
territories. The chart provides a
visual guide to how well
territories are balanced. A
balancing line is included to
show the mean value of a
selected variable for all territo-
ries.

Tips
- You can add more attribute fields
to the chart view by opening the
Territory Layer Properties doalog
box, and choosing from the
available variables in the Chart
tab.

- Add the balancing line in the
Chart tab in the Territory Layer
Properties dialog box.

- Territory names may not be
visible or are truncated in the chart
view if there are too many
characters in a territory name or if
there are many territory columns.

- Right-clicking a territory chart
column provides many different
territory management options.

- Double-clicking any territory
chart column opens the ArcGIS
Symbol Selector. Changing the
color or symbol in the chart view is
also reflected on the map and in the
data and hierarchy views.
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Working in Selection Mode

Selection Mode is a way of working with selections of your
territories and displaying the results for only those selections.
You can access Selection Mode from the Territory Design
toolbar. Selection Mode works in the data view, statistics view,
and chart view.

Selection Mode relates to selections made by the Territory
Select Tool found on the Territory Design toolbar. Selections
made by the standard ArcGIS Select Feature tool do not affect
the Territory Design views when in Selection Mode. It does,
however, turn off Selection Mode.

If you are using Selection Mode for the data view, data are
shown only for elements that are selected in the map.

If you are using Selection Mode for the statistics view, statistics
are shown only for elements that are selected in the map.

If you are using the Selection Mode for the chart view, the chart
is will shown only for elements that are selected in the map.

You can use the Territory Select Tool to work with the map. With
it, you can select data management options such as create a
new territory, reassign a territory, copy, and remove a territory.

A map showing a set of territories with Selection Mode turned on. The TD
Window chart shows only the information for the selected areas.

Selected geographic elements
(ZIP Codes) within territories

Chart representing selected items
only within territories

Hierarchy information is updated
to show only selected features.
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Working in Edit Mode

Edit Mode is a way of working with territories having multiple
hierarchies. When in Edit Mode, Territory Design increases the
thickness of the boundary lines for the active level of territories
and shows geography elements of its base layer, making the

hierarchy levels easily distinguishable. Also, other territory
levels on the map become temporarily invisible. You can edit
territories in Edit Mode using the standard Territory Design
editing features including the Territory Select Tool, and data
view and by draging and dropping territories. The visibility of
the territory levels is restored after turning off Edit Mode.

A map showing a set of regions in Edit Mode. The underlying territories
are made invisible.

A map showing a set of territories. Regions are created from these
territories, but will not be shown until Edit Mode is turned on.

Geographic elements (ZIP Codes)
from the alignment layer that form the
territories

Territories

Alignment layer is
turned off. Underlying territory

boundaries are shown.Alignment layer

Regions are shown and
outlined in bold.
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Setting the territory layer properties

The Territory Layer Properties dialog box is accessed from the
Territory Design toolbar. It can be used to control a variety of
settings for working with the software.

Throughout this section, you will learn more about the different
tabs on the Territory Layer Properties dialog box, including:

• Data tab

• Statistics tab

• Chart tab

• Map Display tab

• Data Source tab
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Setting territory layer
Properties on the Data
tab

1. Click the Territory Layer
Properties button from the
Territory Design toolbar.

The Territory Layer Properties
dialog box opens.

2. Click the Data tab.

3. Choose the available
variables and use the arrows
to move them to the Dis-
played variable(s) area and
make them active. Click
Apply to continue to work
with the territory layer
properties, or click OK to
save your new settings and
close the dialog box.

Territory Layer
Properties:

Data tab
The Data tab allows you to
control what attributes are
included in each level of your
analysis.

Tip
If you add available variables to
the displayed variables window in
the Data tab, the displayed
variables are automatically added
to the territory level database you
are working with. Conversely if
you remove any displayed
variables, they will be removed
from the territory level database.
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Setting territory layer
properties on the
Statistics tab

1. Click the Territory Layer
Properties button from the
Territory Design toolbar.

The Territory Layer Properties
dialog box opens.

2. Click the Statistics tab.

3. Click Add to see a list of
variables.

4. Choose the type of statistic
you want to see from the
drop-down list.

5. Choose the variable you
want to show in the Field
area and click OK.

6. Click Apply to continue to
work with territory layer
properties or click OK to save
your new settings and close
the dialog box.

Territory Layer
Properties:

Statistics tab
The Statistics tab allows you to
control what attribute statistics
are shown in each level of your
analysis.

Tip
The variables that you add on the
Statistics tab will show up in
Territory Design Window.
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Setting territory layer
properties on the Chart
tab

1. Click the Territory Layer
Properties button from the
Territory Design toolbar.

The Territory Layer Properties
dialog box opens.

2. Select the Chart tab.

3. Choose the available
variables and click the right
arrows to move them to the
Displayed variable(s) area
and make them active. Click
Apply to continue to work in
the territory layer properties
or click OK to save your new
settings and close the dialog
box.

Territory Layer
Properties:

Chart tab
The Chart tab allows you to
control what attributes are
included in the Territory Design
charting. You can view the chart
information in the Territory
Design Window on the Chart
tab.

Tip
By checking on the Show balancing
lines check box a line is displayed
in the Territory Design Window
chart showing the mean value of
the attributes you choose. This
provides a visual guide to how well
a territory has been balanced. You
can show more than one attribute
at a time; a balancing line is shown
for each attribute.

Tip
Clicking Chart Properties opens
the standard ArcGIS Advanced
Chart Properties dialog box. You
can further customize your chart
using this dialog box.
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Setting territory layer
properties on the Map
Display tab

1. Click the Territory Layer
Properties button from the
Territory Design toolbar.

The Territory Layer Properties
dialog box opens.

2. Click the Map Display tab.

3. Check the territory levels
where you want to display
internal boundaries.

4. Click Apply to continue to
work with territory layer
properties or click OK to save
your new settings and close
the dialog box.

Territory Layer
Properties:

Map Display tab
The Map Display tab allows
you to control which territory
levels are shown with internal
boundaries in ArcMap. For
example, if you have two
territories created from a set of
30 ZIP Codes, the ZIP Code
boundaries are displayed within
each territory. When a territory
is created, the alignment layer
boundary files are dissolved to
form a contiguous territory
polygon. Displaying the
boundaries can be helpful if
you want to show the total
boundaries within each territory
or the size distribution of the
boundaries.
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Setting territory layer
properties on the Data
Source tab

1. Click the Territory Layer
Properties button from the
Territory Design toolbar.

The Territory Layer Properties
dialog box opens.

2. Click the Data Source tab.

3. Type your workspace file
location or click the browse
button to navigate to a
location.

4. Click Apply to continue to
work with territory layer
properties or click OK to save
your new settings and close
the dialog box.

Territory Layer
Properties:

Data Source tab
The Data Source tab allows you
to control where your Territory
Design analyses are saved. The
information is stored in a file-
based geodatabase.

Tip
By default, the Territory Design
workspace is set to C:\My Output
Data, but you have the option to
save it to any location you choose.
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Setting territory layer
properties on the
Network tab

1. Click the Territory Layer
Properties button from the
Territory Design toolbar.

The Territory Layer Properties
dialog box opens.

2. Click the Network tab.

3. Choose the analysis solver
type from the drop-down list.

4. Click Apply to continue to
work with territory layer
properties or click OK to save
your new settings and close
the dialog box.

Territory Layer
Properties:

Network tab
The Network tab allows you to
control which drive-time
methods Territory Design uses.
You have the option to use
StreetMapTM or Network
Analyst.

Tip
Drive-times can be used in
Territory Design when you balance
territories. For instance you can set
parameters so that a location can’t
exceed a 25-minute drive-time. In
this scenario you, have the option
to choose Network Analyst or
StreetMap to solve the drive-time.

- Network Analyst yields highly
detailed drive-time polygons but
may take longer to create.

- StreetMap produces more
generalized drive-time boundaries,
but works very fast.
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